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Installing

You can install IBM® Operational Decision Manager either through the launchpad
or through Installation Manager. When you install the product, you can also
choose to install a sample server to test the product features, and to run samples
and tutorials on WebSphere® Application Server.

Before you install, make sure that you have a valid license for the products that
you want to install.

After you install, you can use the silent installation to install Operational Decision
Manager on multiple workstations in a network.

Before you install
To improve your installation experience, ensure that you understand the
Operational Decision Manager installation concepts and requirements.

Composition of Operational Decision Manager
When you install Operational Decision Manager, you select a set of components
that you install on a distributed operating system. Your product license specifies
the components that you can install.

You select the components that you want to install through IBM Installation
Manager or through the launchpad. Depending on your license, some components
are optional or required. For example, you must select the appropriate profile
templates when you install through Installation Manager. However, the profile
templates are installed by default through the launchpad.

Any time after you install Operational Decision Manager, you can use Installation
Manager to update your installation to add more components. Installation
Manager checks that your system has the prerequisite software before you install
the new components.

The following figure shows the installable high-level Operational Decision
Manager components:
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By default, the installation directory for both Decision Server and Decision Center
components is the same, that is, they share the same Installation Manager package
group directory.

Operational Decision Manager licenses
Your license type determines which components you can install. Install only the
components that are available under your license agreement.

Various Operational Decision Manager license types are available.

Table 1. License types and corresponding installable components

License type Installable components

Decision Server v Decision Server Rules

v Rules profile templates for WebSphere
Application Server

v Decision Server Events

v Events profile templates for WebSphere
Application Server

v Business Rules Embedded

Decision Server Rule Edition v Decision Server Rules

v Rules profile templates for WebSphere
Application Server

Decision Server Express®
v Decision Server Rules

v Rules profile templates for WebSphere
Application Server

Decision Server Express grants you access to
limited capabilities. For example, you cannot
use Decision Server in a cluster
environment. Check the terms of your
license for more information.

Decision Server Event Edition v Decision Server Events

v Events profile templates for WebSphere
Application Server

Decision Center v Decision Center

v Decision Center profile templates for
WebSphere Application Server

Decision Center Express v Decision Center

v Decision Center profile templates for
WebSphere Application Server

Decision Center Express grants you access to
limited capabilities. For example, you cannot
use Decision Center in a cluster
environment. Check the terms of your
license for more information.

Installable components
IBM Operational Decision Manager is composed of several components that
provide a variety of features. Depending on the type of license that you have, you
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can install some or all of the components and their respective features. Ensure that
you install only the components for which you have a valid license.

When you install through Installation Manager, you select from the following
components:
v Decision Center
v Decision Server Rules
v Decision Server Events
v WebSphere Application Server 8.6 Profile templates for Rules
v WebSphere Application Server 8.6 Profile templates for Events
v Business Rules Embedded

In addition to the product components, you can use Installation Manager or the
launchpad to install the required Operational Decision Manager software
requirements.

For more information about what software is required, see “Software
requirements.”
Related information:
“Installing the product with Installation Manager” on page 13
Use Installation Manager to run a custom installation of Operational Decision
Manager. When you install through Installation Manager, you can select the
Operational Decision Manager components, features, and environments that you
want to install. Ensure that you install only the components for which you have a
valid license.

Software requirements
Before you install Operational Decision Manager, make sure that you have the
required software and environments, and sufficient disk space.

If you install Operational Decision Manager through Installation Manager, the
software requirements are not installed for you. Alternatively, you can use the
launchpad to install the software requirements, including Installation Manager,
before you begin the product installation.

The following table displays the software requirements that are supplied as part of
the installer.

Table 2. Software requirements for Operational Decision Manager.

Software requirements Description

Installation Manager 1.7.1 Install Operational Decision Manager
product packages through Installation
Manager 1.7.1. If you have a version of
Installation Manager, ensure that you have
the minimum version requirement:
Installation Manager 1.7.1.
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Table 2. Software requirements for Operational Decision Manager. (continued)

Software requirements Description

WebSphere Application Server Network
Deployment 8.5.5

Use WebSphere Application Server Network
Deployment V8.5.5 only if you intend to
deploy a sample server or a stand-alone
server. You use WebSphere Application
Server Network Deployment to run the
samples and tutorials, to install the Event
runtime, and to use the Event widgets.
Note: To install WebSphere Application
Server Network Deployment on Linux and
AIX® systems, you must set the process
resource limits in the /etc/security/
limits.conf file. If the value for the number
of open files is too low, errors can occur
when opening files or establishing
connections. To change the open file limit,
edit the /etc/security/limits.conf file, and
add the following values:

hard nofile 100000
soft nofile 100000

WebSphere eXtreme Scale 8.6.0 WebSphere eXtreme Scale is required only if
you intend to use the Event runtime.

WebSphere eXtreme Scale is used to install
the Event runtime. You must install
WebSphere eXtreme Scale in the directory of
WebSphere Application Server.

Eclipse 4.2.2 When you install through Installation
Manager, you can choose to extend an
existing Eclipse. If you choose to extend
your Eclipse, ensure that you have the
required version: Eclipse 4.2.2
Note:

You must update the standard Version of
Eclipse 4.2.2. Go to the Known Limitations
page to follow the steps that you must take
to set update your Eclipse.

For more information about the system and software requirements, see IBM
Operational Decision Manager detailed system requirements
Related tasks:
“Installing with the launchpad” on page 11
Run the launchpad to install a typical installation of your Operational Decision
Manager product components. When you install through the launchpad, you
install your product components and all the available installation features. The
launchpad also installs the required software.
Related information:
“Installing the product with Installation Manager” on page 13
Use Installation Manager to run a custom installation of Operational Decision
Manager. When you install through Installation Manager, you can select the
Operational Decision Manager components, features, and environments that you
want to install. Ensure that you install only the components for which you have a
valid license.
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Downloading the product installers
To install Operational Decision Manager, you must copy or download the
installation disks onto your workstation. If you download the files, you must
extract them with an archiving utility of your choice.

About this task

You can install the installation files either through IBM Passport Advantage®,
physical DVDs, or a downloadable compressed product offering. Ensure that your
installation disks are copied to the same directory.

Procedure
1. Choose the tar file that corresponds to your target operating system.

To avoid any issue with the file extraction, make sure that the path to the
directory is short. You can, for example, extract the tar files to the root of your
hard disk: <InstallDir>/ODM86.

2. Extract the files:
v If you use WinZip, clear TAR file smart CR/LF conversion in Option >

Configuration > Miscellaneous.
v If you are an AIX user, you must use both the native UNIX tar command

and the GNU version of this command because the native utility does not
support long file names.

Results

As a result of the extraction, you obtain four folders that are named disk1, disk2,
disk3, and disk4. Each folder contains the following common elements:
v The launchpad executable file to install the product components along with the

required software.
v A set of response files to install the product in silent mode.

Additionally, each folder contains the following components:
v The disk1 folder contains WebSphere Application Server (WAS directory), IBM

SDK Java™ Technology Edition Version 7.0.4.1 for WebSphere (WASJDK7 directory),
the Installation Manager repositories (IM and IM64), and WebSphere eXtreme
Scale (WXS repository).

v The disk2 folder contains the Decision Server Rules (DecisionServerRules)
directory, the Rules profile templates for WebSphere Application Server
(ProfileTemplateRules) directory, and the Embedded rules (ER) directory.

v The disk3 folder contains the DecisionServerEvents directory and the Events
profile templates for WebSphere Application Server (ProfileTemplateEvents).

v The disk4 folder contains the Decision Center (DC) directory and the Decision
Center profile templates for WebSphere Application Server (ProfileTemplateDC).

Related concepts:
“Installing the product with the launchpad” on page 9
Use the launchpad to run a typical installation of Operational Decision Manager.
When you install through the launchpad, you install everything that you need to
get you up and running with the components that you select. Ensure that you
install only the components for which you have a valid license.
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“Installing on multiple workstations” on page 26
In some cases, Operational Decision Manager must be installed within a specific
configuration on multiple computers. You can install the product components by
running Installation Manager in silent installation mode to automate the process,
and deploy the products to multiple systems.
“Software requirements” on page 3
Before you install Operational Decision Manager, make sure that you have the
required software and environments, and sufficient disk space.
Related information:
“Installing the product with Installation Manager” on page 13
Use Installation Manager to run a custom installation of Operational Decision
Manager. When you install through Installation Manager, you can select the
Operational Decision Manager components, features, and environments that you
want to install. Ensure that you install only the components for which you have a
valid license.

Security
To help you configure applications safely, application servers check access to the
resources and manage access rights.

Operational Decision Manager is certified to support Federal Information
Processing Standards (FIPS) 140-2 and the National Institute of Standards and
Technology (NIST) Special Publications 800-131a security standard.

The FIPS 140-2 standard is an information technology security accreditation
program to certify cryptographic modules for use in government departments and
regulated industries that collect, store, transfer, share, and disseminate sensitive but
unclassified information.

To configure WebSphere Application Server V8.5.5 to run in NIST SP800-131A
mode (transition mode or strict mode), go to the following page: Configuring
WebSphere Application Server for SP800-131 standard strict mode.

Configuration of a secure mode on an application server provides ways to increase
the security of the application that you deploy.

In secure mode, an application server:
v Checks access to the resources: access to a class using the Java reflection

mechanism is not permitted without the appropriate security rights.
v Manages access rights: Rule Execution Server Console access is managed with

this mechanism.

By default, Rule Execution Server is installed with a minimum of security. The
Rule Execution Server Console application defines three specific roles:
resAdministrators, resDeployers, and resMonitors. The roles control access to the
various JSP/Servlets.

There is no specific permissions implementation for Rule Execution Server MBeans.
All that is required to access the MBeans using JMX are the correct credentials.

Java 2 Security provides a policy-based, fine-grain access control mechanism that
increases overall system integrity. Java 2 Security is independent of Java EE
role-based authorization. Java 2 Security can be disabled and enabled
independently of global security. However, on certain application servers when
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global security is enabled, Java 2 Security is also enabled. Note that Java 2 security
can be disabled even though global security is enabled.

Note: Security configuration of Rule Execution Server might relate to your
application, domain, or server-scoped security policy in your enterprise. Review
security settings for applications that call Rule Execution Server with your Java EE
application architect or system administrator as appropriate.

You complete the installation of Decision Center and Rule Execution Server by
using an Installation Settings wizard. For Decision Center, the Installation Settings
wizard helps you create the correct groups in your application server when you set
up security access. For Rule Execution Server, the Installation Settings wizard helps
you create the correct type of database schemas.

Communication protocols
Rule Execution Server support HTTP and the secured HTTPS communication
protocol. You can customize the protocol factory.

Communication with Rule Execution Server supports the HTTP or HTTPS
communication protocols. Communication with Rule Execution Server can occur
from Decision Center or Rule Designer.

You can customize the communication in two ways:
v To support nontrusted certificates in secure mode.
v To support custom protocols.

Secure mode

By default, HTTPS supports only trusted certificates. As a consequence, when you
communicate with Rule Execution Server in secure mode, you cannot connect
using a demo certificate that is not trusted by the default JVM. Your application
server raises an SSL handshake exception if you try to connect using a nontrusted
demo certificate. To enable communication to work with nontrusted certificates,
add the following Java system property in the start script of the application server:

-Dilog.rules.res.allowSelfSignedCertificate=true

To allow HTTPS on nontrusted self-signed certificates for Ant tasks, set the Java
system property ilog.rules.res.allowSelfSignedCertificate to true, as follows:

<property name="ilog.rules.res.allowSelfSignedCertificate" value="true"/>

Custom protocols

You can customize the protocol factory for a specific protocol by using the
following system properties:
v custom.protocol.factory: The fully qualified name of the protocol factory.
v custom.protocol.scheme: The protocol name for which the protocol factory is

customized.
v custom.protocol.defaultPort: The default port used for the protocol if no port is

specified in the URL.
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You must launch the JVM that initiates the HTTP communication with these
system properties and your implementation of the protocol factory class
org.apache.commons.httpclient.protocol.ProtocolSocketFactory in the class path.

The protocol factory specified in custom.protocol.factory is instantiated and
registered if both the following conditions are satisfied:
v The HTTP client is instantiated.
v The protocol in the URL used for communication is the same as the value of the

property custom.protocol.scheme.

You can implement the protocol in one of the following ways:
v Execute an Ant task with the system properties:

-Dcustom.protocol.factory=com.ilog.MyProtocolFactory
-Dcustom.protocol.scheme=https -Dcustom.protocol.defaultPort=443

v Add the properties to the build.xml file:
<property name="custom.protocol.factory" value="com.ilog.MyProtocolFactory"/>
<property name="custom.protocol.scheme" value="https"/>
<property name="custom.protocol.defaultPort" value="443"/>

Third-party tools
When you install Operational Decision Manager, you also install some open source
third-party software tools.

Open source software
Operational Decision Manager includes a number of third-party open-source
libraries and tools to enhance your user experience with the product.
v “Eclipse”
v “Apache Ant”

IBM gratefully acknowledges the work of the Open Source community and the
many independent developers that build and support these Open Source packages.

The open source packages are provided to enhance Operational Decision Manager.
The packages are not supported by IBM and IBM does not endorse their suitability
for production use. For support, refer to the relevant user community through the
Home Page for each package.

Eclipse
Optionally, you can install Eclipse if you do not already have a version of this IDE
installed.

The standard Operational Decision Manager installer provides Eclipse as an
optional environment for the convenience of users. Eclipse is required for
successful application development with Operational Decision Manager, but users
can choose to install Operational Decision Manager onto an existing, version
compatible, Eclipse installation. You do not have to incorporate Eclipse into
applications that you develop using Operational Decision Manager. However,
certain features might require that specific Eclipse libraries be included in the final
application.

Apache Ant
Apache Ant is installed to provide a preconfigured build and deployment scripts.
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Version 1.7.1 of Ant, the Java-based build tool, is provided in the
<InstallDir>/shared/tools/ant directory.

For more information about Ant, see http://ant.apache.org.

Ant is installed as part of the Operational Decision Manager installation. It
provides a preconfigured build and deployment scripts. These scripts are integral
to development of applications that incorporate Operational Decision Manager and
can be useful as an element of the final application. However, they are not
mandatory elements of Operational Decision Manager applications. In Operational
Decision Manager powered applications, all product features are fully functional
even if Ant has not been incorporated into the final application.

Installing Operational Decision Manager
Install Operational Decision Manager through one of two installation methods.
Depending on your installation needs, you can install the product through the
launchpad or through Installation Manager. After you complete the installation,
you can perform a silent installation to deploy Operational Decision Manager on
multiple workstations in a network.

Installing the product with the launchpad
Use the launchpad to run a typical installation of Operational Decision Manager.
When you install through the launchpad, you install everything that you need to
get you up and running with the components that you select. Ensure that you
install only the components for which you have a valid license.

You can find and start the launchpad from <disk1>. When you install through the
launchpad, you install all of the features, the default environments, and the
software requirements for the components that you select. For example, the
launchpad installs Installation Manager and the appropriate profile templates for
WebSphere Application Server. The default application server for Operational
Decision Manager is WebSphere Application Server.

After you install, the sample server does not require any configuration. The profile
is created the first time that you start the sample server.
Related tasks:
“Installing with the launchpad” on page 11
Run the launchpad to install a typical installation of your Operational Decision
Manager product components. When you install through the launchpad, you
install your product components and all the available installation features. The
launchpad also installs the required software.
“Uninstalling Operational Decision Manager” on page 42
Use Installation Manager to uninstall components or the entire Operational
Decision Manager product.
Related information:
“Installing the product with Installation Manager” on page 13
Use Installation Manager to run a custom installation of Operational Decision
Manager. When you install through Installation Manager, you can select the
Operational Decision Manager components, features, and environments that you
want to install. Ensure that you install only the components for which you have a
valid license.
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Starting the launchpad
Double-click one of the launchpad executable files, either launchpad.exe or
launchpad64.exe. You can find the launchpad executable files in <disk1> of the
installation disks.

Before you begin

Save and extract the installation files on your workstation.

Review your user privileges carefully. If you decide to change the default
installation directory for Windows 7, ensure that you are aware of the user
privilege1 limitations for directories under Program Files and Program Files
(x86). Your user privileges depend on your installation of Installation Manager,
and you must install the product with the same user privileges.

Important:

On Windows 7, the Program Files and Program Files (x86) directories are
protected. As a consequence, if you do not install the product as an administrator,
you might encounter difficulties to run certain programs. To avoid this issue,
install the product in a directory other than Program Files and Program Files
(x86).

You must have a web browser to run the launchpad. The launchpad supports
Firefox and Internet Explorer.

About this task

Start the launchpad from <disk1> of the installation disks.

On Windows, if you want to install the product as an administrator, the user
privileges that are required for installing it depend on your version of Windows.
v On Windows 7: You must log in with an account that has administrator

privileges to install or update IBM Installation Manager and the other products.
Run the installer as Administrator by right-clicking the program file or shortcut
and selecting Run as Administrator.
If you want to install the Operational Decision Manager components with an
existing version of Installation Manager that you have on your workstation,
make sure that the User Account Control setting in the Control Panel is not set
at the lowest value. If this value is set to the minimum, the launchpad
automatically opens in administrator mode and installs a new version of
Installation Manager in addition to your existing version of Installation Manager.

v On other supported Windows versions: If you want to install as an
administrator, you must have a user ID that belongs to the Administrator group.

Procedure

To start the launchpad, double-click the launchpad executable file:
v On Windows, start launchpad.exe, or launchpad64.exe. The executable file

determines whether the launchpad is run in 32-bit or 64-bit mode. It does not
determine whether you install a 32-bit or a 64-bit Operational Decision Manager
installation.

1. "User privileges" refer to the administrator and nonadministrator installation options.
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To install the product as an administrator on Windows 7, right-click the
executable file and select Run as Administrator

v On Linux, start ./launchpad.sh.

What to do next

The launchpad guides you through the installation process. Select the components
and options that respond to your installation needs.
Related information:
“Installing with the launchpad”
Run the launchpad to install a typical installation of your Operational Decision
Manager product components. When you install through the launchpad, you
install your product components and all the available installation features. The
launchpad also installs the required software.

Installing with the launchpad
Run the launchpad to install a typical installation of your Operational Decision
Manager product components. When you install through the launchpad, you
install your product components and all the available installation features. The
launchpad also installs the required software.

Before you begin

Review your license and install only the components for which you have a valid
license.

About this task

The launchpad guides you through the installation. When you start the launchpad,
you must first select from the components under Decision Server and Decision
Center. Select the components for which you have a valid license.

Through the launchpad, you can also select your configuration options.

Procedure

To install IBM Operational Decision Manager through the launchpad:
1. Start the launchpad. You can start the launchpad from <disk1>.
2. On the Welcome page, select your product licenses under Decision Server and

Decision Center. Click Next to continue your installation.
3. Select your installation options.

a. Are you installing for production purposes? After you install, is your
product used to server users and clients? If so, select Yes. If not, select No.

b. For Decision Server, select whether you want to install the rules or events
capabilities, or both.

c. The default application server is WebSphere Application Server. If you want
to install artifacts for other application servers, select JBoss, Tomcat, or
Oracle WebLogic.

d. If you want to install the tutorials and samples, select Yes.

Select Next.
4. Under Installation Information, specify a directory in which to install your

product.
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a. In Windows 7, if you run the launchpad in user mode, the default
installation directory is C:\Users\IBM_ADMIN\IBM\ODM86

b. In Windows 7, if you run the launchpad as an administrator, the default
installation directory is C:\Program Files\IBM\ODM86

c. To specify a location other than the default location, click Browse. Note,
however, that on Windows 7, the Program Files and Program Files (x86)
directories are protected. Install the product in a directory other than
Program Files or Program Files (x86) to avoid any user privilege
difficulties.

5. Specify a user name and password. You use the user name and password to
sign in to Decision Center, the WebSphere Application Server administration
console, and use other applications such as the Event widgets. Enter a user
name and password that do not have spaces. The following is an example of an
acceptable user name and password:
v User Name: ODMadmin
v Password: ODMadmin

Important:

For security reasons, you must change your password and remove the
temporary response files that are created by the launchpad after the installation
is complete. These files are generated during the installation process in these
directories:
v On Windows:%TEMP%\IBM_LaunchPad_Typical_Install_<hash_key>
v On UNIX: /tmp/IBM_LaunchPad_Typical_Install<hash_key>

6. Click Next.
7. Review the license agreement and installation summary, and select the check

box to agree to the terms. If you do not select the check box, you cannot
continue with the installation.

8. Click Install Software. The installation begins.
During the installation, the installer prompts you to confirm that you want to
run the Installation Manager and other installation programs, click Yes to
accept.
The installation runs in the background. Do not close the launchpad even if the
progress bar shows 100% completion. Wait until the following message is
displayed: Installation completed successfully.
If you cancel the installation before its completion, the files and folders that are
already copied onto your computer are not deleted. You must uninstall the
products that the launchpad already installed with the Installation Manager,
and manually delete the remaining files before you run the launchpad again.
For more information, see “Uninstalling Operational Decision Manager” on
page 42.

9. Click Next to exit the launchpad.

Results

When the installation is complete, your product components are installed on your
workstation.

By default, they are installed in the following directories:
v Operational Decision Manager: <IBM_InstallDir>/ODM86/ODM, where

<IBM_InstallDir> refers to your IBM installation directory.
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v WebSphere eXtreme Scale and WebSphere Application Server:
<IBM_InstallDir>/ODM86/WAS/AppServer, where <IBM_InstallDir> refers to your
IBM installation directory.

What to do next

Start the sample server with the Start menu shortcut. A profile is configured on
WebSphere Application Server Network Deployment to run the included samples
and tutorials.
Related concepts:
“Post-installation configuration” on page 50
After you install and check your installation, consult the configuration topics for
information about setting up your product. Depending on the installation option
that you select, you might have some configuration work to do.
“Installing the product with the launchpad” on page 9
Use the launchpad to run a typical installation of Operational Decision Manager.
When you install through the launchpad, you install everything that you need to
get you up and running with the components that you select. Ensure that you
install only the components for which you have a valid license.
“Software requirements” on page 3
Before you install Operational Decision Manager, make sure that you have the
required software and environments, and sufficient disk space.
Related information:
“Installing the product with Installation Manager”
Use Installation Manager to run a custom installation of Operational Decision
Manager. When you install through Installation Manager, you can select the
Operational Decision Manager components, features, and environments that you
want to install. Ensure that you install only the components for which you have a
valid license.

Installing the product with Installation Manager
Use Installation Manager to run a custom installation of Operational Decision
Manager. When you install through Installation Manager, you can select the
Operational Decision Manager components, features, and environments that you
want to install. Ensure that you install only the components for which you have a
valid license.

You must have an existing Installation Manager to install Operational Decision
Manager through Installation Manager. You must also ensure that you have the
required software.

When you install through Installation Manager, you select your Operational
Decision Manager components, features, and environments. Contrary to the
launchpad, you can select more finely the features that you want to install.

To install the Operational Decision Manager components, Installation Manager
must access the repositories for the components that you want to install. Edit the
preferences in Installation Manager to set the path to these repositories.
Related concepts:
“Installing the product with the launchpad” on page 9
Use the launchpad to run a typical installation of Operational Decision Manager.
When you install through the launchpad, you install everything that you need to
get you up and running with the components that you select. Ensure that you
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install only the components for which you have a valid license.
“Software requirements” on page 3
Before you install Operational Decision Manager, make sure that you have the
required software and environments, and sufficient disk space.
“Upgrading Operational Decision Manager” on page 42
When you upgrade Operational Decision Manager, you uninstall your current
product version and then install Operational Decision Manager V8.6.
Related tasks:
“Installing with the launchpad” on page 11
Run the launchpad to install a typical installation of your Operational Decision
Manager product components. When you install through the launchpad, you
install your product components and all the available installation features. The
launchpad also installs the required software.
“Uninstalling Operational Decision Manager” on page 42
Use Installation Manager to uninstall components or the entire Operational
Decision Manager product.

Installation Manager overview
Install and maintain your IBM products with IBM Installation Manager.

Operational Decision Manager makes use of the basic Installation Manager
features:
v Select a language pack within the installer.
v Update an existing product package.
v Modify an existing product package.
v Roll back a product package.
v Uninstall a product package.

When you use Installation Manager, select your user privileges carefully. You must
also be aware of a few concepts, such as package groups, the shared directory, and
the Eclipse languages.

User privileges:

You can install Operational Decision Manager as an administrative user (root) or as
a nonadministrative user (nonroot).

You must use the same user to install the required software, for example you must
install Operational Decision Manager and WebSphere Application Server using the
same user.

For more information on the Installation Manager guidelines, see Group road maps
and the user interface and Install as an administrator, non-administrator, or group
in the Installation Manager documentation.

Administrator user

If you want the administrator user (root) to install products on a computer, run the
install executable file that is in the Installation Manager directory.

Nonadministrator user

If you want a specific user to install products on a computer, run the userinst
executable file that is in the Installation Manager directory.
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If you want a group of users to install products on a computer, run the groupinst
executable file. If you install Installation Manager using the group mode, you can
install Installation Manager by using one account and offerings by using another
account that is in the same group.

Note:

The group mode is not supported on Windows.

For more information, see Installation commands in the Installation Manager
documentation.

Package groups and the shared directory:

Installation Manager always installs Operational Decision Manager in a package
group, which is used to group multiple packages into one manageable location.

Installation Manager specifies a default “Package group” and a “Shared resources
directory.”

Package group

A package group is a directory where compatible packages share common
components such as a user interface or workbench.

You can create a package group or install the packages into an existing compatible
package group. Some packages cannot share a package group, in which case the
option to use an existing package group is disabled.

You might want to install the product in an existing package group if you installed
supported versions of compatible products such as IBM Integration Designer or
Rational® Application Developer, or Rational Software Architect, and you want to
extend it with Rule Designer and Event Designer features. For more information,
see “Installing Operational Decision Manager in a compatible IBM product” on
page 19.

When you install several packages at the same time, all the packages are installed
into the same package group. After you create the package group, you cannot
change the installation directory. The installation directory contains files and
resources that are specific to Operational Decision Manager.

Shared resources directory

The shared resources directory is where Eclipse plug-ins and other files are located
so that they can be used by one or more product package groups. You can specify
the shared resources directory only the first time that you install a package. The
name of the shared resources directory depends on the first product that you have
installed.

You cannot change the directory location until you uninstall all packages.

Important: Installation Manager manages the contents of the shared resources
directory. You must not edit or modify any files in this directory.
Related tasks:
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“Installing Operational Decision Manager in a compatible IBM product” on page
19
You can install Operational Decision Manager in a compatible IBM product
package group to share functions and a common user interface.

Languages:

During the installation, you can select the languages to install. English is selected
by default and it is always installed.

Language selection applies only to Eclipse features. A language pack is installed
for each language that you select so that you can start Eclipse in the locale for
these languages.

If you are extending an existing Eclipse, you must select the languages for which
you already have the language packs installed. If you select a language that is not
already installed in your existing Eclipse, you might get an error. To solve this
issue, clear the languages that are not installed in your Eclipse.

The Rule Designer user interface is installed with all the supported locales.
Therefore, even if you do not install a certain locale, for example French, the Rule
Designer views and editors in Eclipse are still shown in this language (French) if
you start Eclipse in this locale.

Setting up Installation Manager preferences
Before you install through Installation Manager, you must add the Operational
Decision Manager installation directories to the Installation Manager preferences.

Procedure
1. Start Installation Manager from the Windows Start menu or from a command

line.
2. Click File > Preferences and specify the repository locations:

v IBM Decision Server Rules: <extractionDir>/disk2/DecisionServerRules/
repository.config

v Rules profile templates for WebSphere Application Server:
<extractionDir>/disk2/ProfileTemplateRules/repository.config

v IBM Decision Server Events: <extractionDir>/disk3/DecisionServerEvents/
repository.config

v Events profile templates for WebSphere Application Server:
<extractionDir>/disk3/ProfileTemplateEvents/repository.config

v IBM Decision Center: <extractionDir>/disk4/DC/repository.config
v Decision Center profile templates for WebSphere Application Server:

<extractionDir>/disk4/ProfileTemplateDC/repository.config
v Business Rules Embedded: <extractionDir>/disk2/ER/repository.config
Installation Manager retrieves the product packages from the specified
repository locations.
For more information on how to set repository locations, see Repository
preferences.

What to do next

After you point to the installation directories, you can start the Installation
Manager installation and select your installation repositories.
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Related information:
“Running Installation Manager”
Start Installation Manager to install one or more Operational Decision Manager
components on your workstation. You must have an existing Installation Manager
and the required software to install through the Installation Manager.
“Installable components” on page 2
IBM Operational Decision Manager is composed of several components that
provide a variety of features. Depending on the type of license that you have, you
can install some or all of the components and their respective features. Ensure that
you install only the components for which you have a valid license.
“Downloading the product installers” on page 5
To install Operational Decision Manager, you must copy or download the
installation disks onto your workstation. If you download the files, you must
extract them with an archiving utility of your choice.

Running Installation Manager
Start Installation Manager to install one or more Operational Decision Manager
components on your workstation. You must have an existing Installation Manager
and the required software to install through the Installation Manager.

Before you begin

Install Installation Manager 1.7.1 and the required software to install Operational
Decision Manager through Installation Manager.

Specify the repository locations in the Installation Manager preferences. For more
information, see “Setting up Installation Manager preferences” on page 16.

About this task

When you install Operational Decision Manager through Installation Manager, you
select the product packages for which you have a valid license. Then, you can
select the features that you want to install.

Follow the Installation Manager panels to select the options that correspond to
your installation needs:
v Select your product packages
v Review the license agreements
v Select a package group and installation directory
v Select languages
v Select features
v Locate your instance of WebSphere Application Server
v Enter a user name and password
v Identify your installation needs: production or nonproduction
v Select your licenses

Procedure

Install Operational Decision Manager with Installation Manager:
1. From the Installation Manager welcome page, select Install.
2. Select the installation packages that correspond to your installation needs and

license entitlements. Then, click Next.
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Ensure that you select the profile templates that correspond to your
installation. For example, if you select Decision Center, make sure that you
also select the Decision Center profile templates for WebSphere Application
Server.
You can install one or all of the packages on the same workstation. For more
information about the features included in each package, see “Features you
can install” on page 21.

3. Review the license agreements for the selected packages. If you agree, select I
accept the terms of the license agreements, and then click Next. If you select
I do not accept the terms in the license agreements, you cannot continue
with the installation.

4. Select a package group:
a. Select Create a new package group to create a new package group for

Operational Decision Manager.
The default package group is ODM86 and its name is IBM Operational
Decision Manager.

Important:

On Windows 7, you can change the default installation directory to a
location outside of Program Files and Program Files (x86) to avoid user
privilege conflicts.

The Program Files and Program Files (x86) directories are protected. You
must install Operational Decision Manager with the same user privileges
that you use to install Installation Manager to run your programs correctly.
For example, if you want to install under Program Files, you might have
to install as an administrator. To avoid issues, install the product in a
directory outside the Program Files or Program Files (x86). For more
information, see “Package groups and the shared directory” on page 15

b. Click Next to continue.
For more information, see “Package groups and the shared directory” on
page 15 and “Installing Operational Decision Manager in a compatible
IBM product” on page 19.

5. Option: If you want to extend your packages to an existing version of Eclipse,
click Extend an existing Eclipse, and then click Browse to locate your
eclipse.exe file.

6. Select the languages to install for this package, and then click Next.
For more information, see “Languages” on page 16.

7. Select the product features that you want to install, and then click Next.
A set of features is already selected by default. For more information on the
features, see “Features you can install” on page 21.

8. Select Application Server Location, and browse to your installation of
WebSphere Application Server where you want to deploy the applications,
and then click Next. For example <IBM_InstallDir>/WebSphere/AppServer.
By default, Operational Decision Manager supports JDK7. If you have an
existing WebSphere Application Server that runs JDK6, you must upgrade
your JDK version by using the installation option IBM WebSphere SDK Java
Technology Edition version 7.0.4.1.

9. Select Server Security, and enter a user ID and password for the sample
server profile on WebSphere Application Server, and then click Next. Your
user ID and password must not contain any white spaces. For example:
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v User ID: odmadmin
v Password: odmadmin
You use the user ID and password to connect to the WebSphere Application
Server administrative console, the Event Widgets and the Events
Administration console.

10. Select the configuration that you require on the Licenses panel. If you intend
to use your installation to server end-users and clients, select Yes. If not, select
No.

11. On the Summary page, review the selected features before you install the
packages, and then click Install.

12. Wait until the installation is complete, and then click Finish.

Results

The product is installed in the directory that you specify when you install. The
default installation directory is <IBM_InstallDir>/ODM86, where <IBM_InstallDir>
refers to your IBM installation directory.

The products and features that are installed depend on what you selected in
Installation Manager, see “Checking your installation” on page 35.

What to do next

To find out what your next steps are and how to get started with your installation,
see “Post-installation configuration” on page 50.
Related concepts:
“Troubleshooting the installation” on page 49
If you encounter difficulties installing the products, you can check the installation
logs or the limitations and known issues technote.
Related information:
“Installing the product in an existing Eclipse environment” on page 20
Installation Manager installs by default a new instance of Eclipse. However, if you
already have a supported version of Eclipse, you can choose to extend your
existing Eclipse.

Installing Operational Decision Manager in a compatible IBM
product
You can install Operational Decision Manager in a compatible IBM product
package group to share functions and a common user interface.

About this task

You can install Operational Decision Manager in the package groups of one of the
following products:
v IBM Eclipse SDK
v Rational Application Developer
v Rational Developer for z (RDz)
v Rational Software Architect

Before you start the installation, make sure that the repository locations of these
products are not selected in the preferences of Installation Manager.

Go to the following support page to check the supported versions:
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v IBM Operational Decision Manager detailed system requirements

Procedure
1. When prompted to select a package group in Installation Manager, select Use

the existing package group.
Installation Manager displays the list of package groups available. The package
groups that are not compatible are disabled.

2. Select the destination package group.
The installation directory is automatically filled with the path to the selected
product.

3. Continue the installation.
Related concepts:
“Package groups and the shared directory” on page 15
Installation Manager always installs Operational Decision Manager in a package
group, which is used to group multiple packages into one manageable location.

Installing the product in an existing Eclipse environment
Installation Manager installs by default a new instance of Eclipse. However, if you
already have a supported version of Eclipse, you can choose to extend your
existing Eclipse.

Installing the required plug-ins and patch level:

Before you install the product in an existing Eclipse environment, make sure that it
contains the required plug-ins, and that the current patch level is installed.

Before you begin

Rule Designer requires Eclipse SDK 4.2.2. Be sure to install the appropriate patch
level. For more information about obtaining the right patch level, see Operational
Decision Manager V8.5 Known Limitations. Follow the procedure that is
documented on the known limitations page.

Procedure

1. Install and extract the correct patch.
2. Select Eclipse > Help > Install new software.
3. Enter a name in the Name field and click OK.
4. Clear the Group items by category. The six software features display.
5. Click Next twice.
6. Accept the terms of the license agreement.
7. When the installation is complete, select Yes to restart.

Results

You can now extend your Operational Decision Manager components in Eclipse.

Extending an existing Eclipse environment:

If the required plug-ins are installed, you can extend your current Eclipse
environment.
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Before you begin

The Eclipse instance to extend must contain an initialization (.ini) file. If there is
no such file, you must create one in the same folder as your Eclipse .exe file. The
.ini file must have the same name as the Eclipse executable file. For example,
eclipse.exe and eclipse.ini.

About this task

The package files are installed in the package group directory that you select, but
the package functions are available in your Eclipse.

Procedure

1. In Installation Manager, when you are prompted to define your Eclipse, select
the check box Extend an existing Eclipse.

2. Browse to your compatible Eclipse IDE installation.
3. Continue the installation.

Features you can install
In Installation Manager, you can select the features that you want to install within
each Operational Decision Manager component.

A default set of features is preselected but you can add or remove features
depending on your needs. For a detailed description of the installable components
and features, see the following sections:
v “Decision Center features”
v “Decision Server features” on page 23
v “Profile templates for WebSphere Application Server” on page 26
v “Business Rules Embedded” on page 26

Installation Manager automatically enforces any dependencies between features
and prevents you from clearing these dependencies.

After you finish installing the packages, you can add or remove features from your
product with the Modify Packages wizard in Installation Manager.

Decision Center features

The following table describes the features available for selection in the IBM
Decision Center component.
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Table 3. Decision Center features

Feature Description

Decision Center An environment for business users to
author, manage, and test their business and
event rules. It includes a repository for
storing business and event rules, and web
interfaces (Decision Center Business Console
and Decision Center Enterprise Console) for
business users to manage decisions.

By default, Decision Center is installed on
the sample server profile on WebSphere
Application Server. After you complete the
installation of the product, you can also
configure and deploy Decision Center on a
different WebSphere Application Server
profile, or install it on other supported
application servers. However, the Decision
Center Business Console is supported on
WebSphere Application Server V8.5.5 only.

Decision Center: Installation artifacts for
other application servers > Decision Center
for Tomcat

Provides the archives to deploy and
configure Decision Center on Tomcat. The
archives are copied to <InstallDir>/
teamserver/applicationservers/tomcat.

For more information, see Configuring.

Decision Center: Installation artifacts for
other application servers > Decision Center
for JBoss

Provides the archives to deploy and
configure Decision Center on JBoss. The
archives are copied to <InstallDir>/
teamserver/applicationservers/JBoss.

For more information, see Configuring.

Decision Center: Installation artifacts for
other application servers > Decision Center
for WebLogic Server

Provides the archives to deploy and
configure Decision Center on WebLogic
Server. The archives are copied to
<InstallDir>/teamserver/
applicationservers/WebLogic.

For more information, see Configuring.

Rule Solutions for Office (for Windows
only)

Rule Solutions for Office provides a way for
business users to create and edit business
rules in Microsoft Word or Excel.

This option copies the installer for Rule
Solutions for Office to your installation
directory. The executable file for the installer
is copied to <InstallDir>/Rule Solutions
for Office/RuleSolutionsForOffice.exe,
see “Installing Rule Solutions for Office” on
page 35

Samples and Tutorials Installs the projects for the samples and
tutorials, and provides the sample server
profile to run the samples and tutorials on
WebSphere Application Server.

WebSphere Application Server is a
prerequisite for this option.
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Table 3. Decision Center features (continued)

Feature Description

Local help system The local help system option is selected by
default. Eclipse users who want to access the
local help through the F1 key must install
the product documentation locally.

For more information, see Installing and
accessing the documentation locally.

Important: The local help system does not
work on 64-bit platforms, such as Red Hat
Enterprise Linux (RHEL) that do not have a
32-bit compatibility library installed.

Decision Server features

The following table shows the features in the IBM Decision Server package.

Table 4. Components shared between Decision Server Rulesand Decision Server Events.

Shared components Description

Samples and Tutorials Installs the projects for the samples and
tutorials, and provides the sample server
profile to run the samples and tutorials on
WebSphere Application Server.

WebSphere Application Server is a
prerequisite for this option.

Update sites for installation into other
Eclipse products

Provides compressed files that contain the
Eclipse update sites (and a copy of the
Designer plug-ins) to install Rule Designer
and Event Designer features into an existing
Eclipse. This feature provides an alternative
way of installing the Designer plug-ins into
a supported Eclipse after the installation of
Operational Decision Manager.

For more information, see Extending Eclipse
with the Rule Designer update sites.

Local help system The local help system option is selected by
default. Eclipse users who want to access the
local help through the F1 key must install
the product documentation locally.

For more information, see Installing and
accessing the documentation locally.
Important: The local help system does not
work on 64-bit platforms, such as Red Hat
Enterprise Linux (RHEL) that do not have a
32-bit compatibility library installed.
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Table 5. Decision Server Rules

Decision Server Rules Features Description

Rule Designer Rule Designer is a development environment
within Eclipse to design business rule
applications. It is aimed at developers,
business analysts, and architects. The Rule
Designer views and editors are available from
the Rule perspective in Eclipse.

Rule Designer > Scorecard Modeler Scorecard Modeler is a set of extra plug-ins
that are integrated into Rule Designer. You
can use Scorecard Modeler to create
scorecards, integrate them into your business
rules, and share them across multiple
platforms.

Rule Execution Server Rule Execution Server is an execution
platform for business rules that embeds the
rule engine. It also provides a console to
manage and monitor the execution of
business rules.

By default, Rule Execution Server is installed
on the sample server profile on WebSphere
Application Server. After you complete the
installation of the product, you can also
configure and deploy Rule Execution Server
on a different WebSphere Application Server
profile, or install it on other supported
application servers.

Select your intended use in accordance with
your license type:

Non-production license
Select this option if you want to use
the product for development
purposes.

This license can be deployed only as
part of development and test
environment for internal
non-production activities.

Production license
Select this option if you want to use
the product for production.

Rule Execution Server: Installation artifacts
for other application servers > Rule
Execution Server for Tomcat

Provides the archives to deploy and configure
Rule Execution Server on Tomcat. The
archives are copied to <InstallDir>/
executionserver/applicationservers/tomcat.

For more information on how to use the
archives to deploy and configure Rule
Execution Server, see Configuring Rule
Execution Server.

24 IBM Operational Decision Manager: Installation Guide

http://www.ibm.com/support/knowledgecenter/SSQP76_8.6.0/com.ibm.odm.distrib/../com.ibm.odm.distrib.config/topics/odm_distrib_config.html
http://www.ibm.com/support/knowledgecenter/SSQP76_8.6.0/com.ibm.odm.distrib/../com.ibm.odm.distrib.config/topics/odm_distrib_config.html


Table 5. Decision Server Rules (continued)

Decision Server Rules Features Description

Rule Execution Server: Installation artifacts
for other application servers > Rule
Execution Server for JBoss

Provides the archives to deploy and configure
Rule Execution Server on JBoss. The archives
are copied to <InstallDir>/executionserver/
applicationservers/JBoss.

For more information on how to use the
archives to deploy and configure Rule
Execution Server, see Configuring Rule
Execution Server.

Rule Execution Server: Installation artifacts
for other application servers > Rule
Execution Server for WebLogic Server

Provides the archives to deploy and configure
Rule Execution Server on WebLogic Server.
The archives are copied to
<InstallDir>/executionserver/
applicationservers/ WebLogic.

For more information on how to use the
archives to deploy and configure Rule
Execution Server, see Configuring Rule
Execution Server.

Table 6. Decision Server Events

Decision Server Events features Description

WebSphere Application Server is a prerequisite for Decision Server Events.

Event Designer A development environment within Eclipse
to design, develop, test, deploy, and monitor
event applications. Event Designer is
available from the Event perspective in
Eclipse.

Runtime > Event Runtime The event runtime is an execution platform
that manages real-time business event
coordination. The event runtime requires
WebSphere eXtreme Scale and must be
deployed and configured on WebSphere
Application Server.

Select your intended use in accordance with
your license type:

Non-production license
Select this option if you want to use
the product for development
purposes.

This license can be deployed only
as part of development and test
environment for internal
non-production activities.

Production license
Select this option if you want to use
the product for production.

Runtime > Event Tester Enabler If Event Tester Enabler is selected, then the
Event Tester widget is available.
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Table 6. Decision Server Events (continued)

Decision Server Events features Description

Runtime > Event Connectors (Legacy) Event connectors provide data connections
between the event runtime and external
systems. Legacy connectors include email
and ftp.

Event Widgets for Decision Server The Event Tester widget provides a way to
test the event logic in a business process.
This widget is aimed at testing and must be
used only on a test installation. Do not use it
on a production installation as it might
affect performance.

Integration Components You can install integration components into
the tooling of WebSphere ESB and
WebSphere Message Broker to allow these
products to send and receive data from
Decision Server Events.

Profile templates for WebSphere Application Server

When you install one of the Decision Server Events, Decision Server Rules, or
Decision Center features, you must also install the corresponding profile templates.
There are three profile templates:
v Rules profile templates for WebSphere Application Server
v Events profile templates for WebSphere Application Server
v Decision Center profile templates for WebSphere Application Server

Thes components contain the events and rules template profiles and runtime that
are required to deploy Operational Decision Manager on a WebSphere Application
Server.

For details on profile templates, see Operational Decision Manager profile
templates.

Business Rules Embedded

With Business Rules Embedded, you can use business rules to dynamically
configure the behavior of an Eclipse Rich Client Platform (RCP) application or a
Dojo-based web application.

For detailed information about this component, see Business Rules Embedded.

Installing on multiple workstations
In some cases, Operational Decision Manager must be installed within a specific
configuration on multiple computers. You can install the product components by
running Installation Manager in silent installation mode to automate the process,
and deploy the products to multiple systems.

You perform a silent installation by running Installation Manager with response
files that correspond to the products that you want to install. Template response
files are provided with the installer to help you perform a silent installation.
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Setting the response file for Installation Manager
Configure the response file for Installation Manager to install Installation Manager
silently.

About this task

In silent mode, there is no interaction with the Installation Manager user interface.

Operational Decision Manager is bundled with Installation Manager version 1.7.1.
Installation Manager version 1.7.1 or later is required to install the Operational
Decision Manager products.

Procedure

To install Installation Manager silently:
1. Go to the location where you extracted the Operational Decision Manager

installation disks and go to<InstallDir>/disk1/IM/.
If you use Windows 64-bit or Linux 64-bit, the directory is
<InstallDir>disk1/IM64.

2. Go to the directory diskX/responsefiles.
The responsefiles directory is available from any disk.

3. In the file IM_Silent.xml, replace !IM_REPOSITORY! with the path to the
directory where the Installation Manager installer is located. A typical value is
<install_root>/disk1/IM.

What to do next

After you install Installation Manager, you must set the response files for the
Operational Decision Manager prerequisites and components that you want to
install.

Setting the response file for required software
WebSphere Application Server and WebSphere eXtreme Scale are prerequisites to
the installation of the other Operational Decision Manager packages. WebSphere
eXtreme Scale is required if you want to install Decision Server Events. You can
install them silently using the provided response files.

About this task

Installation Manager uses response files to run the installation in silent mode. The
following procedure explains how to set up the provided response files to run a
silent installation for WebSphere Application Server and WebSphere eXtreme Scale.

Procedure

Setting up the response file for WebSphere Application Server

1. Go to the location where you extracted the Operational Decision Manager
installation disks and go to: diskX\responsefiles.
Response files are available on any disk.

2. Open the was_and_jdk_silent.xml silent file in a text editor.
3. Replace !WAS_REPOSITORY! with the path where the WebSphere Application

Server installer is located. For example: <install_root>\disk1\WAS.
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4. Replace !WAS_JDK_REPOSITORY! with the path where your WebSphere
Application Server JDK is located. For example: <install_root>\disk1\
WASJDK7.

5. Replace the variable !WAS_PROFILE! by any string. This value is used by
Installation Manager to give a name to the WebSphere Application Server
installation profile. The default value is WebSphere Application Server V8.5.5.

6. Replace the variable !WAS_INSTALL_LOCATION! by the path to the directory
where you want to install WebSphere Application Server. For example:
c:\Program Files\IBM\WAS.

7. If you want to install WebSphere Application Server in 64-bit mode, replace
the variable !BIT_64! by the value indicated in the file.

8. Replace the variable !WAS_SDK6_BIT_VERSION! by the value
com.ibm.sdk.6_32bit or com.ibm.sdk.6_64bit depending on whether you
want to install a 32-bit or a 64-bit WebSphere Application Server.

9. Save the was_and_jdk_silent.xml silent file.
Setting up the response file for WebSphere eXtreme Scale

10. Go to the location where you extracted the Operational Decision Manager
installation disks and go to diskX/responsefiles.

11. Open the WXS_Silent.xml silent file in a text editor.
12. Set the variable !WAS_PROFILE! found in <offering

id='com.ibm.websphere.wxs.was8.v86' profile='!WAS_PROFILE!'
features='xs.core.feature,xs.client.feature,xs.liberty.feature,xs.server.feature,xs.console.feature'
installfixes='none'/> to the same value as your !WAS_PROFILE!.

Note:

If you install on an existing WebSphere Application Server installation, you
must set the value of the !WXS_PROFILE! to the installation package group
name in Installation Manager. When you install, you can find the installation
package group name under Package Group Name. After you install, you can
find package group name under Installed Packages and Fixes in Installation
Manager.

13. Replace !WXS_REPOSITORY! with the location of your WebSphere eXtreme Scale
repository.

14. Replace !WAS_INSTALL_LOCATION! with the location of your WebSphere
Application Server installation.

15. Save the WXS_Silent.xml silent file.

Setting the response file for Decision Center
Configure the response file for the silent installation of Decision Center.

About this task

Installation Manager uses response files to run the installation in silent mode. The
following procedure explains how to set up the provided response files to run a
silent installation for Decision Center.

Consult the list of features in the table for a list of the available Decision Center
features.
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Table 7. List of features to install

Product List of features

Decision
Center

v Decision Center

v Rule Solutions for Office

v jdk

v base

v com.ibm.wbdm.dts.tomcat.feature

v com.ibm.wbdm.dts.jboss.feature

v com.ibm.wbdm.dts.weblogic.feature

v com.ibm.wdc.rules.samples.feature

Procedure
1. Go to the location where you extracted the Operational Decision Manager

installation disks and go to diskX/responsefiles. Response files are available
on any disk.

2. Open the dc_silent.xml in a text editor. Under Mandatory Variables to be
replaced, you have a list of variables that must be replaced throughout the
file.

3. Replace !DC_IM! with your Decision Center repository location.
4. Replace !ODM_INSTALL_LOCATION! with the installation path for you

Operational Decision Manager profile.
5. Replace !WAS_INSTALL_LOCATION! with the installation location for

WebSphere Application Server.
6. Replace !ODM_PROFILE! with a profile name for Operational Decision

Manager.
7. Replace !WAS_USER! to create a WebSphere Application Server user profile.
8. Replace !WAS_PASSWORD! to create a password for your WebSphere

Application Server profile.
9. Replace !DC_FEATURES! with the Decision Center features that you want to

install. Table 1 lists the Decision Center features that you can install.
10. Replace !DC_LIC! with full or express, depending on your license.

What to do next

Ensure that you replace the variables in the dc_pt_silent.xml response file for the
Decision Center profile templates for WebSphere Application Server.

Setting the response file for Decision Server Rules
Configure the response file for the silent installation of Decision Server Rules.

About this task

Installation Manager uses response files to run the installation in silent mode. The
following procedure explains how to set up the provided response files to run a
silent installation for Decision Server Rules.

Consult the list of features in the table for a list of the available Decision Server
Rules features.
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Table 8. List of features to install

Product List of features

Decision
Server Rules

v com.ibm.wds.jdk.feature

v com.ibm.wds.rules.studio.feature

v com.ibm.wds.rules.res.feature

v com.ibm.wds.updatesites.feature

v base

v com.ibm.wds.rules.res.tomcat.feature

v com.ibm.wds.rules.res.jboss.feature

v com.ibm.wds.rules.res.weblogic.feature

v com.ibm.wds.rules.samples.feature

Procedure
1. Go to the location where you extracted the Operational Decision Manager

installation disks and go to diskX/responsefiles. Response files are available
on any disk.

2. Open the ds_rules_silent.xml silent file in a text editor. Under Mandatory
Variables to be replaced, you have a list of variables that must be replaced
throughout the file.

3. Replace !DSR_IM! with the DecisionServerRules Installation Manager
directory.

4. Replace !ODM_INSTALL_LOCATION! with the installation path for your
Operational Decision Manager profile.

5. Replace !WAS_INSTALL_LOCATION! with the installation location for
WebSphere Application Server.

6. Replace !ODM_PROFILE! with a profile name for Operational Decision
Manager.

7. Replace !DS_RULES_FEATURES! with a comma-separated list of the Decision
Server Rules features that you want to install. Table 1 lists the Decision Server
Rules features that you can install.

8. Replace !DSR_LICENSE! with full, rules, or express, depending on your
license.

9. Replace !WAS_USER! to create a WebSphere Application Server user profile.
10. Replace !WAS_PASSWORD! to create a password for your WebSphere

Application Server profile.
11. Replace !DSR_PRODUCTION! with True or False. True is for production

purposes. False is for non-production purposes.
12. Save the ds_rules_silent.xml silent file.

What to do next

Ensure that you set the variables in the ds_pt_rules_silent.xml response file for
the Decision Server Rules profile templates for WebSphere Application Server.

Setting the response file for Decision Server Events
Configure the response file for the silent installation of Decision Server Events.
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About this task

Installation Manager uses response files to run the installation in silent mode. The
following procedure explains how to set up the provided response files to run a
silent installation for Decision Server Events.

Consult the list of features in the table for a list of the available Decision Server
Events features.

Table 9. List of features to install

Product List of features

Decision
Server
Events

v com.ibm.wds.jdk.feature

v com.ibm.wds.studio.events.feature

v com.ibm.wds.events.runtime.feature

v com.ibm.wds.events.connectors.feature

v com.ibm.wds.event.widgets.feature

v com.ibm.wds.events.propertiesui.feature

v com.ibm.wds.updatesites.feature

v base

v com.ibm.wds.events.samples.feature

Procedure
1. Go to the location where you extracted the Operational Decision Manager

installation disks and go to diskX\responsefiles. Response files are available
on any disk.

2. Open the ds_events_silent.xml silent file in a text editor. Under Mandatory
Variables to be replaced, you have a list of variables that must be replaced
throughout the file.

3. Replace !DSR_IM! with the DecisionServerEvents Installation Manager
directory.

4. Replace !ODM_INSTALL_LOCATION! with the installation path for your
Operational Decision Manager profile.

5. Replace !WAS_INSTALL_LOCATION! with the installation location for
WebSphere Application Server.

6. Replace !ODM_PROFILE! with a profile name for Operational Decision
Manager.

7. Replace !DS_EVENTS_FEATURES! with a comma-separated list of the
Decision Server Events features that you want to install. Table 1 lists the
Decision Server Events features that you can install.

8. Replace !DSE_LICENSE! with full or events, depending on your license.
9. Replace !WAS_USER! to create a WebSphere Application Server user profile.

10. Replace !WAS_PASSWORD! to create a password for your WebSphere
Application Server profile.

11. Replace !DSE_PRODUCTION! with True or False. True is for production
purposes. False is for non-production purposes.

12. Save the ds_events_silent.xml silent file.
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What to do next

Ensure that you set the variables in the ds_pt_events_silent.xml response file for
the Decision Server Events profile templates for WebSphere Application Server.

Setting the response file for Embedded Rules
Configure the response file for the silent installation of Embedded Rules.

About this task

Installation Manager uses response files to run the installation in silent mode. The
following procedure explains how to set up the provided response files to run a
silent installation for Embedded Rules.

Procedure
1. Go to the location where you extracted the Operational Decision Manager

installation disks and go to diskX/responsefiles. Response files are available
on any disk.

2. Open the er_silent.xml silent file in a text editor. Under Mandatory Variables
to be replaced, you have a list of variables that must be replaced throughout
the file.

3. Replace !ER_IM! with the Embedded Rules Installation Manager directory.
4. Replace !ODM_PROFILE! with a profile name for Operational Decision Manager.
5. Replace !ODM_INSTALL_LOCATION! with the installation path for your Operational

Decision Manager profile.
6. Save the er_silent.xml silent file.

Setting the response file for the WebSphere Application Server
profile templates
If Decision Center and Decision Server are to be deployed on WebSphere
Application Server, you can set up a response file to install the corresponding
profile templates and runtime silently.

About this task

Installation Manager uses response files to run the installation in silent mode. The
following procedure explains how to set up the provided response files to run a
silent install for Profile templates for WebSphere Application Server.

Procedure
1. Go to the location where you extracted the Operational Decision Manager

installation disks and go to: diskX/responsefiles.
Response files are available on any disk.

2. In the file dc_pt_silent.xml:
a. Replace the !PT_DC_IM! variable with the ProfileTemplateDC repository.
b. Replace the !ODM_INSTALL_LOCATION! variable with the path to your

Operational Decision Manager profile templates. For example,
<install_root>/disk1/responsefiles/

c. Replace the !WAS_INSTALL_LOCATION! variable with the path to your
WebSphere Application Server installation.

d. Replace the !ODM_Profile! variable with a profile name for your installation
of WebSphere Application Server.

e. Replace the !DC_LIC! variable with your Decision Center license.
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3. In the ds_pt_rules_silent.xml file:
a. Replace the !PT_RULES! variable with the path to the ProfileTemplateRules.

For example: <InstallDir>/disk2/ProfileTemplateRules.
b. Replace the !ODM_INSTALL_LOCATION! variable with the path to your

Operational Decision Manager profile templates. For example,
<install_root>/disk1/responsefiles/

c. Replace the !WAS_INSTALL_LOCATION! variable with the path to your
WebSphere Application Server installation.

d. Replace the !ODM_Profile! variable with a profile name for your installation
of WebSphere Application Server. The profile corresponds to the Installation
Manager profile, not to the WebSphere Application Server profile.

e. Replace the !DSR_License! variable with your Decision Server Rules license.
f. If your installation is for production purposes, enter true. If your installation

is not for production purposes, enter false.
4. In the ds_pt_events_silent.xml file:

a. Replace the !PT_EVENTS! variable with the path to the
ProfileTemplateEvents. For example: <InstallDir>/disk3/
ProfileTemplateEvents.

b. Replace the !ODM_INSTALL_LOCATION! variable with the path to your
Operational Decision Manager profile templates. For example,
<install_root>/disk1/responsefiles/

c. Replace the !WAS_INSTALL_LOCATION! variable with the path to your
WebSphere Application Server installation.

d. Replace the !ODM_Profile! variable with a profile name for your installation
of WebSphere Application Server. The profile corresponds to the Installation
Manager profile, not to the WebSphere Application Server profile.

e. Replace the !DSE_License! variable with your Decision Server Events
license.

f. If your installation is for production purposes, enter true. If your installation
is not for production purposes, enter false.

Installing Operational Decision Manager silently
After all the response files are set up, you can start a silent installation.

About this task

The following procedure explains how to perform a silent installation of
Operational Decision Manager with Installation Manager. The installation must be
performed in the shown order.

Procedure
1. To install Installation Manager, run one of the following commands from

<InstallDir>/disk1/IM or from <InstallDir>/disk1/IM64:
v If you are an administrator, enter:

installc.exe -input <path_to_silent_file>/IM_Silent.xml -acceptlicense

Alternatively, you can enter: installc.exe -silent -acceptLicense

v If you are not an administrator, enter:
userinstc <path_to_silent_file>/IM_Silent.xml -acceptlicense

Alternatively, you can enter: userinstc -silent -acceptLicense

2. To install WebSphere Application Server:
v On Windows systems:
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a. Go to the directory where you installed Installation Manager.
b. Go to the directory eclipse/tools.
c. Type the command imcl.exe -input <path_to_response_file>/

was_and_jdk_silent.xml -acceptLicense.
v On UNIX systems:

a. Go to the directory where you installed Installation Manager.
b. Go to the directory eclipse/tools.
c. Type the command ./imcl input <path_to_response_file>/

was_and_jdk_silent.xml -acceptLicense.
3. To install WebSphere eXtreme Scale:

v On Windows systems:

a. Go to the directory where you installed Installation Manager.
b. Go to the directory eclipse/tools.
c. Type the command:

imcl.exe -input <path_to_response_file>\wxs_Silent.xml
-acceptLicense

v On UNIX systems:

a. Go to the directory where you installed Installation Manager.
b. Go to the directory eclipse/tools.
c. Type the command:

./imcl input <path_to_response_file>/wxs_Silent.xml -acceptLicense

4. To install the Operational Decision Manager components:
v On Windows systems:

a. Go to the directory where you installed Installation Manager.
b. Go to the directory eclipse/tools.
c. Type the command:

– Decision Center: imcl.exe -input <path_to_response_file>\
dc_silent.xml -acceptLicense

– Decision Server Rules: imcl.exe -input <path_to_response_file>\
ds_rules_silent.xml -acceptLicense

– Decision Server Events: imcl.exe -input <path_to_response_file>\
ds_events_silent.xml -acceptLicense

– Embedded Rules: imcl.exe -input <path_to_response_file>\
er_silent.xml -acceptLicense

v On UNIX systems:

a. Go to the directory where you installed Installation Manager.
b. Go to the directory eclipse/tools.
c. Type the command:

– Decision Center: ./imcl input <path_to_response_file>/
dc_silent.xml -acceptLicense

– Decision Server Rules: ./imcl input <path_to_response_file>/
ds_rules_silent.xml -acceptLicense

– Decision Server Events: ./imcl input <path_to_response_file>/
ds_events_silent.xml -acceptLicense

– Embedded Rules: ./imcl input <path_to_response_file>/
er_silent.xml -acceptLicense

5. To install profile templates for WebSphere Application Server:
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v On Windows systems:

a. Go to the directory where you installed Installation Manager.
b. Go to the directory eclipse/tools.
c. Type the command:

– Decision Center profile templates: imcl.exe -input
<path_to_response_file>\dc_pt_silent.xml -acceptLicense

– Decision Server Rules profile templates: imcl.exe -input
<path_to_response_file>\ds_pt_rules_silent.xml -acceptLicense

– Decision Server Events profile templates: imcl.exe -input
<path_to_response_file>\ds_pt_events_silent.xml -acceptLicense

v On UNIX systems:

a. Go to the directory where you installed Installation Manager.
b. Go to the directory eclipse/tools.
c. Type the command:

– Decision Center profile templates: ./imcl input
<path_to_response_file>/dc_pt_silent.xml -acceptLicense

– Decision Server Rules profile templates: ./imcl input
<path_to_response_file>/ds_pt_rules_silent.xml -acceptLicense

– Decision Server Events profile templates: ./imcl input
<path_to_response_file>/ds_pt_events_silent.xml -acceptLicense

Installing Rule Solutions for Office
Once the installation of Decision Center is complete, you can manually run the
installer for Rule Solutions for Office.

Before you begin

If you installed the product with Installation Manager, make sure that you selected
the Rule Solutions for Office feature, see “Features you can install” on page 21.

You must have a supported version of Microsoft Office to install Rule Solutions for
Office. For details, see Working with Microsoft Office.

About this task

Rule Solutions for Office is an optional component that provides a way for
business users to create and edit business rules in Microsoft Word or Excel. The
Rule Solutions for Office feature in Installation Manager copies the installer for
Rule Solutions for Office to your installation directory.

Procedure
1. Navigate to <InstallDir>/Rule Solutions for Office/

2. Double-click the RuleSolutionsForOffice.exe file to run it.
3. Follow the steps in the installation wizard.

Checking your installation
You can verify the content of the installation directory and use shortcuts to access
product components and information.
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Folders in the installation directory
After you finish installing the Operational Decision Manager components, you can
verify the content of the installation directory.

In your file system, go to your <InstallDir> folder: for example, C:\Program
Files\IBM\ODM86. The Operational Decision Manager components are installed in
the following folders:

Table 10. Component-folder mapping

Component Folders

Decision Server Rules

Rule Designer studio

Rule Execution Server executionserver

Getting started tutorials gettingstarted

Shared third-party tools shared

Sample server shared/samplesServer

.NET engine and migration tool dotnet

Configuration files and plug-ins for Rule
Designer

configuration

Local help system and XML schemas doc

Extensions to Rule Designer dropins

Files to package plug-ins into a feature
during Eclipse configuration processing

features

Eclipse plug-ins plugins

JDK (Windows only) jdk

License agreement files license

Provisioning system files p2

Decision Server Events

Legacy event connectors connectors

Files that support the event runtime engine.
This directory also includes the compressed
files for downloading and installing the
Event Tester, and the Event Capture and
Event Replay widgets.

runtime

Events connectors ca

Configuration files config

Configuration files and plug-ins for Event
Designer

configuration

Extensions to Event Designer dropins

Integration with other IBM products such as
WebSphere Message Broker and WebSphere
ESB

integration

Decision Center teamserver, Rule Solutions for Office
(optional)

Business Rules Embedded rules-sdk
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IBM Installation Manager installs the Eclipse plug-ins in the shared resources
directory. The shared resources directory contains resources that can be shared by
one or more package groups. This directory is managed by IBM Installation
Manager and you must not modify anything in this directory.

The Eclipse plug-ins are also copied to <InstallDir>/studio/update-sites
providing that you selected the corresponding option in IBM Installation Manager
when installing the product. The update sites are delivered as ZIP files that you
can extract to view the plug-ins.

If you install the component Profile templates for WebSphere Application Server,
the corresponding folders are located in the following directories:

<WAS_InstallDir>/profileTemplates/rules for rules profiles.

<WAS_InstallDir>/profileTemplates/wbe for events profiles.

Menu shortcuts
For each component that you install in Windows, the installer adds shortcuts to the
menu. You can access the shortcuts through the start menu.

Your choice of installation determines what shortcuts the installer adds to the
shortcut menu. If, for example, you choose Rule Designer, the shortcut for Rule
Designer is added. If you choose Rule Execution Server, the shortcut for the Rule
Execution Server console is added.

Start menu navigation Shortcuts

Start > All Programs > IBM >
Package_Group

The following is available under the package group
level:

v Event Designer opens Eclipse in the Event
perspective.

v IBM Knowledge Center opens the product
documentation online.

v Information center for Operational Decision
Manager (local) starts the local version of the
product documentation.

v Rule Designer opens Eclipse in the Rule
perspective.

v Rule Solutions for Office opens rule solutions for
Office. This shortcut is only available if you install
Rule Solutions for Office. To install Rule Solutions
for Office, you must select the corresponding
option in Installation Manager. You then run the
installation manually by using the provided .exe
file in <InstallDir>/Rule solutions for Office.

Start > All Programs > IBM >
Package_Group > Getting Started
Tutorials

The following is available under Getting Started
tutorials:

v Decision Center Business console opens the
Getting Started for the Business console.

v Decision Center Enterprise console opens the
Getting Started for the Enterprise console.

v Decision Server Events opens the Getting Started
for Events.

v Decision Server Rules opens the Getting Started
for Business Rules.
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Start menu navigation Shortcuts

Start > All Programs > IBM >
Package_Group > Help and
Support

You can use this shortcut to find the following
documentation and support information:

v Collect Data for Problem Analysis opens the IBM
Support Assistant Data Collector for collecting
diagnostic data.

v Online Support opens the IBM Support home
page.

Start > All Programs > IBM >
Package_Group > Sample Server

You can use this shortcut to access the following
sample server tools and functions.

v Events tools:

– Connectors opens the tooling for Events legacy
connectors.

– Event Widgets opens the web application in a
web browser.

– Properties opens the Properties tool.

v Administrative console opens the WebSphere
Application Server administrative console.

v Decision Center Business console opens the
Decision Center Business console and targets a
database that contains the provided sample
projects in the en_US persistence locale.

v Decision Center Enterprise console opens the
Decision Center Enterprise console, and targets a
database that contains the provided sample
projects in the en_US persistence locale.

v Events Administration console opens the
Administration user interface for Events.

v Rule Execution Server Console opens the Rule
Execution Server console.

v Samples console (en_US) opens Eclipse in the
Samples console perspective with the en_US locale
(American English).

v Start server starts the sample profile on
WebSphere Application Server.

v Stop server stops the sample profile on
WebSphere Application Server.

Shortcut commands
A list of the components that you can access via shortcut commands.

The installer adds relevant shortcuts in batch (.bat) files on Windows and Bash
shell script (.sh) files on Linux.

You can consult the shortcut commands for your respective operating system
environment:
v “Windows”
v “Linux” on page 39

Windows

38 IBM Operational Decision Manager: Installation Guide



Shortcuts Windows commands

Administrative console (Sample
Server)

<InstallDir>/shared/bin/
Administrativeconsole.bat

Connectors <InstallDir>/connectors/bin/connectors.bat

Decision Center Enterprise console
(Sample Server)

<InstallDir>/shared/bin/dcecopener.bat

Decision Center Business console
(Sample Server)

<InstallDir>/shared/bin/dcbcopener.bat

Events Administration console <InstallDir>/shared/bin/EventRuntimeopener.bat

Event Designer <InstallDir>/eclipse.exe -init -consolelog
-perspective com.ibm.wbe.BusinessEvents

Getting Started for Decision Server
Rules

<InstallDir>/images/
GettingStartedServerRules.bat

Getting Started for Decision Center
Business console

<InstallDir>/images/
GettingStartedCenterBusinessConsole.bat

Getting Started for Decision Center
Enterprise console

<InstallDir>/images/
GettingStartedCenterEnterpriseConsole.bat

Getting Started for Decision Server
Events

<InstallDir>/images/
GettingStartedServerEvents.bat

Information center (remote) <InstallDir>/images/InfoCenterOnline.bat

Collect Data for Problem Analysis <InstallDir>/shared/isadc/index.html

Properties <InstallDir>/connectors/bin/propertiesui.bat

Rule Execution Server console
(Sample Server)

<InstallDir>/shared/bin/dsopener.bat

Rule Designer <Eclipse_InstallDir>/eclipse.exe -init
-consolelog -perspective
ilog.rules.studio.ui.perspectives.RuleEditingPerspective

Samples console (en_US) <Eclipse_InstallDir>/eclipse.exe -init
-consolelog -nl en_US -perspective
ilog.rules.studio.samples.console.perspectives.SamplesPerspective

Start server (Sample Server) <InstallDir>/shared/bin/startserver.bat

Stop server (Sample Server) <InstallDir>/shared/bin/stopserver.bat

Linux

Shortcuts Linux commands

Administrative console (Sample
Server)

<InstallDir>/shared/bin/Administrativeconsole.sh

Connectors <InstallDir>/connectors/bin/connectors.sh

Decision Center Enterprise console
(Sample Server)

<InstallDir>/shared/bin/dcecopener.sh

Decision Center Business console
(Sample Server)

<InstallDir>/shared/bin/dcbcopener.sh

Events Administration console <InstallDir>/shared/bin/EventRuntimeopener.sh

Event Designer <InstallDir>/eclipse -init -consolelog
-perspective com.ibm.wbe.BusinessEvents

Getting Started for Decision Server
Rules

<InstallDir>/images/GettingStartedServerRules.sh
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Shortcuts Linux commands

Getting Started for Decision Center
Business console

<InstallDir>/images/
GettingStartedCenterBusinessConsole.sh

Getting Started for Decision Center
Enterprise console

<InstallDir>/images/
GettingStartedCenterEnterpriseConsole.sh

Getting Started for Decision Server
Events

<InstallDir>/images/
GettingStartedServerEvents.sh

Information center (remote) <InstallDir>/images/InfoCenterOnline.sh

Collect Data for Problem Analysis <InstallDir>/shared/isadc/start_isadc.sh

Properties <InstallDir>/connectors/bin/propertiesui.sh

Rule Execution Server console
(Sample Server)

<InstallDir>/shared/bin/dsopener.sh

Rule Designer <Eclipse_InstallDir>/eclipse -init -consolelog
-perspective
ilog.rules.studio.ui.perspectives.RuleEditingPerspective

Samples console (en_US) <Eclipse_InstallDir>/eclipse -init -consolelog
-nl en_US -perspective
ilog.rules.studio.samples.console.perspectives.SamplesPerspective

Start server (Sample Server) <InstallDir>/shared/bin/startserver.sh

Stop server (Sample Server) <InstallDir>/shared/bin/stopserver.sh

Starting Rule Designer
Open Rule Designer from the start menu shortcut, or from the Eclipse that contains
Rule Designer. You can update the configuration file to open Rule Designer in a
specific locale.

Opening Rule Designer
You can open Rule Designer from the start menu shortcut, or by starting the
Eclipse that contains Rule Designer.

About this task

You can open Rule Designer from the start menu shortcut, or by starting the
Eclipse that contains Rule Designer.

By default, Rule Designer opens in the locale of your operating system. If you
want to change the locale of Rule Designer, see “Opening Rule Designer in a
specific locale” on page 41.

Procedure

To open Rule Designer, do one of the following actions:
v Click Start > All Programs > IBM > package_group > Rule Designer .

package_group refers to the package group specified in IBM Installation Manager
during installation. The default package group is Operational Decision Manager
V8.6.

v Start the Eclipse in which you have installed Rule Designer, and switch to the
Rule perspective.
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Results

On IBM AIX and SUN Solaris, Rule Designer runs in headless Eclipse. This means
that you can only start Rule Designer from the command line.

If you have used a previous version of Rule Designer, perform a full clean and
then rebuild your existing projects in the Eclipse workspace the first time you start
V8.6. For more information, see Migrating from JRules V7.

The Eclipse Welcome page (Help > Welcome) provides an entry point to the
overview, tutorials, and samples.
Related information:
“Opening Rule Designer in a specific locale”
You can start Rule Designer in a locale other than the locale of your operating
system. If you are using a bidirectional locale, you can also change the display
orientation of Eclipse.

Opening Rule Designer in a specific locale
You can start Rule Designer in a locale other than the locale of your operating
system. If you are using a bidirectional locale, you can also change the display
orientation of Eclipse.

About this task

By default, Rule Designer opens in the locale of your operating system. You can
change the locale by adding a property to the config.ini file.

Note:

Rule Designer opens in the specified locale if you have selected the locale in IBM
Installation Manager, when installing Decision Server.

Procedure

To change the locale of Rule Designer:
1. Open <InstallDir>/configuration/config.ini.

<InstallDir> refers to the installation directory of Operational Decision Manager.
However, if you installed Operational Decision Manager in an existing Eclipse,
the config.ini file is located in the configuration folder of your Eclipse
installation directory.

2. Add the following properties:
v osgi.nl=<locale>: to specify the locale, for example osgi.nl=fr_FR.
v (Optional) eclipse.orientation=<orientation>: to change the display

orientation of Eclipse, for example eclipse.orientation=ltr.
ltr defines a left-to-right orientation, and rtl defines a right-to-left
orientation.
For bidirectional locales such as Arabic and Hebrew, the rule editors are
localized and displayed from right to left. However, the rest of the Rule
Designer interface is not localized. If you start Eclipse in a bidirectional
locale, it is displayed from right to left, but Rule Designer remains in
English. You can use the ltr value to display Rule Designer from left to
right, and the editors from right to left.

3. Save the changes.
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Note:

v You can also use the -nl <locale> argument in the command line to start
Eclipse. For example, -nl fr_FR.

v You can also use the -dir <orientation> argument in the command line to
start Eclipse with a specific orientation. For example, -dir ltr.

Related information:
“Opening Rule Designer” on page 40
You can open Rule Designer from the start menu shortcut, or by starting the
Eclipse that contains Rule Designer.
Defining a calendar format

Upgrading Operational Decision Manager
When you upgrade Operational Decision Manager, you uninstall your current
product version and then install Operational Decision Manager V8.6.

You can add or remove components and features through the Modify option in
Installation Manager. However, to update your product version, you must reinstall
Operational Decision Manager. You cannot use the Update option in Installation
Manager to update Operational Decision Manager.

Before you update, stop all processes that might access existing Operational
Decision Manager databases. In particular, if you use Derby databases, stop the
Derby Java process, and ensure that your current database directory does not have
a residual Derby lock file. The presence of the Derby lock file causes the
installation to fail. To remove the Derby lock file, go to <InstallDir>/shared/data/
derby/resdb and remove the db.lck file.

Uninstall your current version of Operational Decision Manager through
Installation Manager, and then install Operational Decision Manager V8.6 either
through the launchpad or through Installation Manager.
Related tasks:
“Uninstalling Operational Decision Manager”
Use Installation Manager to uninstall components or the entire Operational
Decision Manager product.
Related information:
“Installing the product with Installation Manager” on page 13
Use Installation Manager to run a custom installation of Operational Decision
Manager. When you install through Installation Manager, you can select the
Operational Decision Manager components, features, and environments that you
want to install. Ensure that you install only the components for which you have a
valid license.

Uninstalling Operational Decision Manager
Use Installation Manager to uninstall components or the entire Operational
Decision Manager product.

Before you begin

Before you uninstall, stop all processes that might access existing Operational
Decision Manager databases. In particular, if you use Derby databases, stop the
Derby Java process, and ensure that your current database directory does not have
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a residual Derby lock file. The presence of the Derby lock file causes the
installation to fail. To remove the Derby lock file, go to <InstallDir>/shared/data/
derby/resdb and remove the db.lck file.

Stop all the applications that run with the product, including the server, the local
help, and any instance of Rule Designer or Event Designer.

Manually delete the ODMSample8600 profiles for WebSphere Application Server and
WebSphere eXtreme Scale before you uninstall. The ODMSample8600 profiles are
created when you install the Sample server from the launchpad. For more
information, see Deleting profiles.

If your packages have any dependencies, you must uninstall the packages and
their respective dependencies.

You must have the same user privileges to uninstall Operational Decision Manager
as you use to install the product on your workstation. Log in to your workstation
with the same user account that you use to install the product packages.

Uninstall Operational Decision Manager with the correct instance of Installation
Manager:
v If you installed the product as an administrator, you must use the administrator

instance of Installation Manager to uninstall it. You can access the administrator
instance through the IBM Installation Manager start menu shortcut. Right click
IBM Installation Manager, and then select Run as administrator.

v If you installed the product as a nonadministrator user, you must use the
nonadministrator instance of Installation Manager to uninstall it. You can access
the nonadministrator instance through the IBM Installation Manager start menu
shortcut.

About this task

Remove components and features through the Modify option in Installation
Manager. Remove the entire Operational Decision Manager product through the
Uninstall option in Installation Manager.

Procedure
1. Close the programs that you installed with Installation Manager.
2. Start Installation Manager from the Start menu.
3. Depending what you want to uninstall, click Modify or Uninstall. Select

Modify to uninstall components and features. Select Uninstall to uninstall the
entire Operational Decision Manager product.

4. Select the components that you want to uninstall, then click Next and
Uninstall.

Related concepts:
“Upgrading Operational Decision Manager” on page 42
When you upgrade Operational Decision Manager, you uninstall your current
product version and then install Operational Decision Manager V8.6.
“Installing the product with the launchpad” on page 9
Use the launchpad to run a typical installation of Operational Decision Manager.
When you install through the launchpad, you install everything that you need to
get you up and running with the components that you select. Ensure that you
install only the components for which you have a valid license.
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Related information:
“Installing the product with Installation Manager” on page 13
Use Installation Manager to run a custom installation of Operational Decision
Manager. When you install through Installation Manager, you can select the
Operational Decision Manager components, features, and environments that you
want to install. Ensure that you install only the components for which you have a
valid license.

What's next?
Review the following topics after you install Operational Decision Manager.

Installing and accessing the documentation locally
You can access the product documentation over the internet. However, you can
install a local version of the documentation if you want to work offline or do not
have an internet access. If you are an Eclipse user, you must install the
documentation locally to be able to consult it from within the IDE.

Downloading the product documentation on your computer
To consult the product documentation locally, you must download the
documentation files on your computer.

Before you begin

The Local help system option is checked by default in the Installation Manager. To
consult the documentation locally, you must first start the local help and then
download the documentation files. Note that the download of the files requires
you to have access to the internet. This access will no longer be required later.

About this task

Important:

The local help system does not work on 64-bits platforms such as Red Hat
Enterprise Linux (RHEL) that do not have a 32-bits compatibility library installed.

Procedure
1. Start the help system in one of the following ways:

v In the Start menu, click All Programs > IBM > package_group >
Information center for Operational Decision Manager (local).
package_group refers to the package group specified in IBM Installation
Manager during installation. The default package group is Operational
Decision Manager.

v Run the following script:
– <InstallDir>/doc/help_start.bat on Windows
– <InstallDir>/doc/help_start.sh on Linux.

To run the information center in a locale other than English, add the locale
argument (-nl xx_XX) to the <InstallDir>/doc/help_start.bat or
<InstallDir>/doc/help_start.sh file, before the -vmargs argument. For
example:
-eclipsehome eclipse -nl fr_FR -configuration configuration_iehs

A new browser window opens. The documentation does not display because
you still must download the documentation content.
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Important:

If you installed the product on Windows 7 in the Program Files or Program
Files (x86) directory without administrator privileges, you might not be
able to start the help system. To avoid potential issues, be sure to install the
product with administrator rights or in a different directory.

2. Click Update in the toolbar to display a list of the documentation sets that
are already installed.

3. Click Next to display a list of documentation sets that you can install. The list
includes documentation sets in English and other supported languages.

4. Click Install. The Update wizard installs the documentation.
5. Click OK, then click Finish.
6. Refresh the page to view the documentation.

Results

The documentation is installed on your computer.

Accessing the local contextual help in Rule Designer
To access the product documentation and the contextual help from within Rule
Designer or Event Designer, you must download the documentation files locally.

Before you begin

By default, the local help system is installed on your machine unless you uncheck
the corresponding option in Installation Manager. You must then download the
files onto your local disk through an Internet connection. For more information, see
“Downloading the product documentation on your computer” on page 44.

About this task

To use the local contextual help from Rule Designer, you must start the local
instance of the information center. The installer inserts the necessary parameters to
access the help from Rule Designer.

If you want to change the parameters to point to a different instance of the
information center, for example a shared information center server running on an
internal network, you can modify the values in Rule Designer.

Procedure

To access the local help in Rule Designer:
1. Check that the settings to use the local help are set correctly in Rule Designer:

a. Click Window > Preferences > Help > Content.
b. Make sure Include remote help and give it priority is selected.
c. Select the link to the information center and click Edit.
d. Make sure that the local information center has the following values:

v Name: Operational Decision Manager information center
v Host: localhost
v Path: /help
v Use port: 3333

e. Click OK, and then click Apply and OK.
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2. Start the local help:
v In the Start menu, click All Programs > IBM > package_group >

Information center for Operational Decision Manager (local).

v Run the <InstallDir>/doc/help_start.bat (Windows) or
<InstallDir>/doc/help_start.sh (Linux)

Important:

If you installed the product on Windows 7 in the Program Files or Program
Files (x86) directory without administrator privileges, you might not be able
to start the help system. To avoid potential issues, be sure to install the product
with administrator rights or in a different directory.

3. On the Help menu, click Help Contents.
If you have already installed the documentation, the local information center
for the Operational Decision Manager product family, Decision Center, and
Decision Server is displayed.
If the documentation has not been installed, follow the steps as described in
“Downloading the product documentation on your computer” on page 44.

Running a shared information center on an internal network
You can run the information center on an internal network.

Before you begin

Before running the information center on an internal network, make sure that you
have installed the documentation locally as described in “Downloading the
product documentation on your computer” on page 44.

About this task

If you have selected the Local help system option, you can set the help system up
so that the information center runs on an internal network.

Procedure

To start the information center on an internal network:
1. Run <InstallDir>/doc/IC_start.bat on Windows or <InstallDir>/doc/

IC_start.sh on Linux.
By default, the shared information center runs on port 9999.

2. Optional: To modify the default port, edit the IC_start.bat or IC_start.sh file,
and modify the port argument. For example, -port <port_number>.
When the shared information center is started, it is accessed using browsers
from other systems at the address http://<hostname>:<port>/help.

Note: To access different locales in the information center, specify the locale at
the end of the URL. For example, http://<ic_hostname>:9999/help/
index.jsp?lang=xx_XX

The locales include de_DE, es_ES, fr_FR, it_IT, ja_JP, ko_KR, pl_PL, pt_BR,
ru_RU, zh_CN, and zh_TW.

3. Optional: Configure the help preferences in Rule Designer to access the
information center:
a. Click Window > Preferences > Help > Content.
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b. Select Include remote help and give it priority, then click New.
c. Enter the values for the information center that you want to connect to, for

example:
v Name: Operational Decision Manager information center
v Host: <ic_hostname>
v Path: /help
v Use port: 9999

d. Click OK, and then click Apply and OK.
The contextual help now uses your new parameters.

Stopping the local help
Before uninstalling the Operational Decision Manager offerings in Installation
Manager, you must stop the information center process to avoid encountering
uninstallation issues.

To stop the local information center:
v On Windows, run <InstallDir>/doc/help_end.bat.
v On Linux, run <InstallDir>/doc/help_end.sh.

To stop the shared information center:
v On Windows, run <InstallDir>/doc/IC_end.bat.
v On Linux, run <InstallDir>/doc/IC_end.sh.

Redirecting contextual help in Rule Execution Server
Change the address to which the contextual help in Rule Designer points. By
default, Rule Execution Server points to the online documentation. However, you
can redirect the contextual help in Rule Designer to point to a local or network
instance of the documentation.

About this task

To redirect the contextual help, you must first update the context parameter in the
EAR file of the Rule Execution Server, and then redeploy the EAR file.

Procedure
1. Update Jrules-res_management-WAS85.ear.

a. In a file manager, go to <installDir>/ODM/executionserver/
applicationservers/WebSphere85.

b. Extract jrules-res-management-WAS85.ear and jrules-res-management.war.
c. Open WEB-INF.
d. Open web.xml in a text editor.
e. Set the following parameters to the appropriate contextual help addresses.

v ilog.rules.res.HELP_CONTEXT

v ilog.rules.res.HELP_INDEX

v ilog.rules.res.HELP_TOPIC

For more information, see “Installing and accessing the documentation
locally” on page 44.

f. Save web.xml.
g. Recreate the archive.

2. Redeploy Jrules-res_management-WAS85.ear.
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a. Start the sample server. <InstallDir>/IBM/Operational Decision Manager
V8.6/Sample Server/Start Server.
To start the sample server, you can also go to <InstallDir>/shared/bin, and
then start startserver.bat or startserver.sh, depending on your operating
system.

b. Start the WebSphere Application Server administrative console.
<InstallDir>/IBM/Operational Decision Manager V8.6/Sample
Server/Administrative console.
To start the sample WebSphere Application Server administrative console,
you can also go to <InstallDir>/shared/bin, and then start
AdministrativeConsole.bat or AdministrativeConsole.sh, depending on
your operating system.

c. Sign in. You must enter the credentials that you provide when you install
the product.

d. Select Applications > Application Types > WebSphere enterprise
applications. The Enterprise Applications table displays.

e. Select jrules-res-management-WAS85.
f. Click Update.

The Application update options display.
g. Under Specify the path to the replacement ear file, browse to and select

your EAR file jrules-res-management-WAS85.ear.
Under Local file system, browse to <InstallDir>/ODM/executionserver/
applicationservers/WebSphere85 and select jrules-res-management-
WAS85.ear.

h. Click Next, and continue to click Next until you get an option to Finish,
and then click.

i. Click Finish.
The Save option appears at the bottom of the screen.

j. Click Save.
k. Sign out of the administrative console.

Results

When you sign in to the Rule Execution Server console, the help link opens the
offline contextual help.

Starting the sample server
Before you develop, test, and run the samples and tutorials, you must start the
Sample Server. You can start the sample server from the Start menu.

About this task

No additional configuration is required start the sample server.

When you start the sample server for the first time, the ODMSample profile is
configured on WebSphere Application Server Network Deployment to run the
included samples and tutorials.

Start the sample server from the Start menu shortcut.
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Procedure

From the Start menu, click All Programs > IBM > package_group > Sample Server
> Start server. package_group refers to the package group specified in IBM
Installation Manager when you install the product. The default package group is
Operational Decision Manager V8.6. The profile creation takes several minutes to
complete. Wait until the build completes successfully.

What to do next

You can perform a number of introductory tasks using the environment that is
installed for you by the sample server installer:
v Perform the Getting started tutorials, and other component-specific tutorials, see

Tutorials
v Run the samples from the samples console in Eclipse, see Product samples.

For more information, see Using the sample server

Note:

v If you are using the sample server profile to run Events, you can use the same
username and password to log in to the Event Widgets and to the Events
Administration console.

v Single sign-on (SSO) authentication is activated for the sample server. With SSO,
users can log in once and gain access to all applications without being prompted
to log in again for each of them. If you use different sign-on credentials for the
applications on the sample server, for example when performing certain samples
and tutorials, you get an error message when you attempt to sign in to the
second application.
To avoid this issue, you must sign out of the first console and then sign in to the
second console. Alternatively, you can sign in to all of the applications on the
server by using the credentials that you entered at installation time.

Troubleshooting the installation
If you encounter difficulties installing the products, you can check the installation
logs or the limitations and known issues technote.

When you contact IBM support, make sure that you have the following
information at hand:
v Version of Installation Manager installed
v Components installed and version numbers
v Operating system
v Installation Manager logs

Installation logs

If you have difficulties installing the product through Installation Manager,
retrieve the installation logs to find out more information on the issues
encountered.
v Installation Manager:

– Windows 2000, XP, and 2003: C:\Documents and Settings\All
Users\Application Data\IBM\Installation Manager\logs

– Windows Vista, 7, and 2008: C:\ProgramData\IBM\Installation
Manager\logs
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– UNIX: /var/ibm/InstallationManager/logs

For more information, see Finding IBM Installation Manager
troubleshooting logs.

v Launchpad:
– Windows: %TEMP%\IBM_LaunchPad_Typical_Install_<hash_key>\

%TEMP% is the environment variable that defines the location of your
Temp directory. <InstallType> refers to the type of installation that you
selected. If the launchpad fails before even starting the installation, no
installation type is indicated in the folder name.

– UNIX: /tmp/IBM_LaunchPad_Typical_Install<hash_key>/

Limitations and known issues

To find a list of the current limitations and known issues, check the
technote Known limitations in Operational Decision Manager V 8.6.

Setting up your environment to automate processes
To deploy RuleApps to Rule Execution Server, automate managerial tasks within
Decision Center, and run many of the samples, you must have Ant installed on
your computer.

About this task

The required version of Ant is 1.7.1 (or later). If Ant is not installed, or your
version is older than version 1.7.1, you must set up your environment to use the
correct version of Ant.

You can download Ant from http://ant.apache.org/, or you can use the Ant 1.7.1
distribution packaged in the following directory: <InstallDir>/shared/tools/ant.

Procedure

To test and set up your environment to use Ant:
1. Set the ANT_HOME environment variable to <InstallDir>/shared/tools/ant.
2. Set the JAVA_HOME environment variable to the path to your JDK installation

(version 1.7.1).
3. Add the directory <InstallDir>/shared/tools/ant/bin to your PATH

environment variable.
4. Test your current version of Ant by typing the following in a Windows

command prompt or UNIX shell:
ant -version

Post-installation configuration
After you install and check your installation, consult the configuration topics for
information about setting up your product. Depending on the installation option
that you select, you might have some configuration work to do.

Your post-installation configuration depends on the components that you install
and your use of the product. You might, for example, use an application server
other than WebSphere Application Server. You might, for example, want to use
your product installation for production purposes. Both examples require
configuration after you install.
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Configuring your application server

The default application server is WebSphere Application Server. If you select the
artifacts for another application server when you install, you must configure your
product. Consult the appropriate configuration topics. For more information, see
the configuration topics.
v Configuring Operational Decision Manager on Tomcat
v Configuring Operational Decision Manager on JBoss
v Configuring Operational Decision Manager on Oracle WebLogic Server

Configuring your application on a production server

After you install Rule Designer and Event Designer, some configuration is required
before you can start to design your application in Decision Server:
v To execute your rule-based application, see Configuring Rule Execution Server.
v To execute your application with event processing, see Configuring Decision

Server Events.
v To deploy the Operational Decision Manager runtime profile templates for

WebSphere Application Server, see Operational Decision Manager profile
templates

v For business users to edit and test rules in Decision Center, see Configuring.

For more information, see “Configuring your application on a production server.”

To get a better understanding of the development lifecycle with Operational
Decision Manager, see Business rule application development.
Related tasks:
Configuring Decision Server Events on WebSphere Application Server
“Installing with the launchpad” on page 11
Run the launchpad to install a typical installation of your Operational Decision
Manager product components. When you install through the launchpad, you
install your product components and all the available installation features. The
launchpad also installs the required software.
Related information:
Configuring Rule Execution Server on WebSphere Application Server
Configuring the Decision Center consoles on WebSphere Application Server
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM United Kingdom Laboratories,
Mail Point 151,
Hursley Park,
Winchester,
Hampshire,
England SO21 2JN

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
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websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM United Kingdom Laboratories,
Mail Point 151,
Hursley Park,
Winchester,
Hampshire,
England SO21 2JN

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
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imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
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